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ch−¬ng tr×nh so¹n th¶o phim  “Adobe 

Premiere” 

1. Giíi thiÖu chung  

1.1  Giíi thiÖu vÒ ch−¬ng tr×nh Adobe Premiere  

Víi sù næi tiÕng cña ch−¬ng tr×nh xö lý ¶nh Adobe Photoshop, h·ng Adobe ®· 

®−a ra ch−¬ng tr×nh so¹n th¶o phim Adobe Premiere. §©y lµ ch−¬ng tr×nh so¹n 

th¶o phim  ®−îc rÊt nhiÒu ®µi truyÒn h×nh còng nh− c¸c trung t©m Multimedia 

sö dông bëi tÝnh chuyªn nghiÖp cña nã.  

 Ch−¬ng tr×nh Adobe Premiere cã thÓ lµm viÖc víi c¶ hai hä m¸y tÝnh phæ biÕn 

®ã lµ IBM-PC vµ Macintosh.  Ngoµi bé so¹n th¶o, Adobe Premiere cßn cung cÊp 

c«ng cô hç trî nhiÒu thiÕt bÞ phÇn cøng ®Ó thu vµ ph¸t tÝn hiÖu DV víi nhiÒu 

chuÈn kh¸c nhau. 

  NÕu b¹n cã c¸c yªu cÇu víi h·ng Adobe th×  cã thÓ liªn l¹c th«ng qua ®Þa chØ :  

www.adobe.com 

Ch−¬ng tr×nh yªu cÇu hÖ thèng tèi thiÓu: 

 Computer :       Intel Pentium Processor  

Operating System:  Windows 98 or Windows 2000 

§Üa cøng :        60 Mb Free for minimum installation 

ThiÕt bÞ kh¸c :       æ CD-ROM  , æ mÒm . 

Monitor:                  256 color display  

Display Adapter:     24 bit Color 

Sound card:             16 bit  

Ram :                      32 Mb  

Bµn phÝm , chuét  vµ c¸c thiÕt bÞ kh¸c . 

(  Ch−¬ng tr×nh nµy chay tèt h¬n nÕu cã CPU tèc ®é cao vµ l−îng Ram lín.) 
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Cµi ®Æt ch−¬ng tr×nh Adobe Premiere 

 Adobe Premiere 6.0 ®−îc l−u gi÷ trªn ®Üa cµi ®Æt CD-Rom. ViÖc cµi ®Æt ch−¬ng 

tr×nh rÊt dÔ dµng víi sù h−íng dÉn trùc tiÕp trªn mµn h×nh.  

1.1.1  C¸c b−íc cµi ®Æt 

i. §−a ®Üa CD-Rom cµi ®Æt Adobe Premiere vµo æ CD, kÝch phÝm tr¸i 

chuét vµo biÓu t−îng CD-ROM  

ii.  Chän Setup Adobe Premiere    

iii. Theo c¸c chØ dÉn trªn mµn h×nh ®Ó hoµn thµnh viÖc cµi ®Æt .  

(Chó ý khi setup Adobe Premiere mét sè phÇm mÒm phô trî cho viÖc 

hiÓn thÞ Video ®−îc cµi ®Æt thªm.) 

1.2  Ch¹y ch−¬ng tr×nh Adobe Premiere 

•   Khëi ®éng ch−¬ng tr×nh . 

 Tõ Start menu 

 Tõ My Computer hoÆc Windows Explorer  

• Tõ Start menu 

1. KÝch vµo Start trªn taskbar.  

2. Chän Program  

3. Chän Adobe Premiere . 

2.  Giao diÖn  c¬ b¶n cña Adobe Premiere 

2.1  Giao diÖn khi khëi ®éng ch−¬ng tr×nh  

Víi Adobe Premiere 6.0  chóng ta cã thÓ nhËp Video, so¹n th¶o Video, 

audio vµ chuçi c¸c ¶nh. Premiere cung cÊp c¸c cöa sæ cã tÝnh trùc quan cao víi 

nhiÒu b¶ng mÉu cã s½n. Còng nh− vËy, b¹n cã thÓ t¹o c¸c cöa sæ hiÓn thÞ chÝnh 

cho  c¸c tÖp trong cöa sæ Project 
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2.2  C¸c cöa sæ giao diÖn  

B¾t ®Çu víi Premiere :  Ch−¬ng tr×nh cã rÊt nhiÒu cöa sæ,  nh− vËy cã thÓ   

chia mµn h×nh sö dông thµnh 4 phÇn chÝnh ®ã lµ phÇn so¹n th¶o, phÇn  danh 

s¸ch c¸c file ®−îc import, phÇn t¹o hiÖu øng Video vµ audio, phÇn hiÓn thÞ 

Project qu¶n lý
c¸c file 

PhÇn hiÓn thÞ c¸c tÖp 
nguån còng nh− kÕt 

Cöa 
sæ  
t¹o 
c¸c 
hiÖu 
øng 

Cöa 
sæ  
so¹n 
th¶o 
Video 
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tÖp gèc còng nh− c¸c tÖp kÕt qu¶. Tuy nhiªn trong qu¸ tr×nh lµm viÖc chóng 

ta còng cã thÓ ®Æt l¹i cöa  sæ nµy cho phï hîp h¬n vµ ghi l¹i ®Ó sö dông cho 

c¸c phÇn sau .Mµn h×nh khi khëi t¹o Premiere lÇn ®Çu.  

  Project  ®ã lµ phÇn qu¶n lý c¸c tÖp (clip).  Chóng ta cã thÓ nhËp (import) 

c¸c file Video, Audio, ¶nh, text... 

  Chóng ta cã thÓ so¹n th¶o video b»ng c¸ch kÐo c¸c file trong cöa sæ 

project xuèng cña sæ Timeline vµ thùc hiÖn so¹n th¶o trong cöa sæ Timeline. 

 Trong phÇn t¹o c¸c hiÖu øng chóng ta cã thÓ t¹o c¸c hiÖu øng mét c¸ch 

nhanh chãng b»ng c¸ch kÐo c¸c biÓu t−îng hiÖu øng ®ã vµo c¸c ®o¹n video  

trong cöa sæ Timeline.  

  Chóng ta cã thÓ xem néi dung cña c¸c file b»ng cöa sæ monitor, sau ®ã c¾t 

xÐn vµ ®−a xuèng cöa sæ Timeline 

2.3  ThiÕt ®Æt Project  

 Tr−íc khi b¹n lùa chän mµn h×nh hiÓn thÞ cña m×nh th× b¹n cÇn ph¶i  t¹o mét 

project.  

Project dïng ®Ó qu¶n lý c¸c tÖp nguån còng nh− c¸c tham sè video cho qu¸ tr×nh 

so¹n th¶o. ë ®©y b¹n cã thÓ chän  nhãm  c¸c thuéc tÝnh phï hîp víi c¸c chuÈn 

DV, Quicktime hoÆc Video cho Windows (c¸c lùa chän ë ®©y lµ t¹o mét m«i 

tr−êng lµm viÖc tèt 

cho viÖc so¹n th¶o 

film). Sau ®ã 

chóng ta cã thÓ 

input nhiÒu  file 

hoÆc mét file víi 

c¸c thuéc tÝnh file 

lµ Video , Audio, 

¶nh ...  vµo cöa sæ 

Project. 
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Khëi t¹o Project : 

Chän File > New Project  , hép héi tho¹i hiÓn thÞ nh− h×nh d−íi: 

   B¹n cã thÓ chän mét trong c¸c môc ë b¶ng chän trªn ®Ó thay ®æi c¸c tham sè 

nh− lµ khung h×nh Video, hÖ NTSC, PAL, SECAM.., tÇn sè AUDIO, chÕ ®é nÐn, 

chÊt l−îng... C¸ch ®¬n gi¶n lµ nªn lùa chän c¸c th«ng sè cã tÝnh ®ång bé hoÆc 

theo c¸c chØ dÉn cã s½n.  

   VÝ dô nÕu kÝch cì cña Video gèc (trªn m¸y quay) cña chóng ta cã kiÓu NTSC 

vµ khu«n h×nh 720x480 th× chóng ta còng lùa chän kiÓu NTSC vµ khu«n h×nh 

720x480 cho  viÖc so¹n th¶o Video trong m¸y tÝnh.  

2.4  Cöa sæ hiÓn thÞ th− viÖn c¸c hiÖu øng cña video vµ audio 

    C¸c th− viÖn nµy cho phÐp chóng ta lùa chän nhanh mét hiÖu øng ®Ó ¸p dông 

cho Video.     

   C¸c c«ng cô trong hép c«ng cô ®−îc lùa chän b»ng c¸ch nhÊn vµo mét biÓu 

t−îng c«ng cô nµo ®ã, mét d·y c¸c c«ng cô Èn sÏ ®−îc hiÓn thÞ, lùa chän mét 

c«ng cô  cÇn thiÕt. 

 

 

 

 

 

 

 C¸c b¶ng mÉu ®−îc hiÓn thÞ trªn mµn h×nh trong lÇn khëi ®éng ®Çu tiªn. NÕu 

kh«ng muèn hiÓn thÞ hay muèn hiÓn thÞ c¸c b¶ng mÉu nµy th× chóng ta vµo môc 

Window> Show hoÆc Window>Hide. 

2.5  Cöa sæ project  
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Cöa sæ nµy qu¶n lý c¸c tÖp tin  cho qu¸ tr×nh so¹n th¶o . 

Trong cöa sæ nµy cã 3 phÇn :  

PhÇn A : Mµn h×nh hiÓn thÞ néi dung vµ c¸c th«ng tin cña mét file ®−îc lùa chän  

 

 

 

 

 

 

 

 

 

 PhÇn B: Danh môc c¸c th− môc chøa c¸c file  Audio, video, ¶nh text... 

 PhÇn C: Danh môc c¸c file trong th− môc. Chóng ta cã thÓ hiÓn thÞ c¸c 

file nµy d−íi d¹ng danh s¸ch, biÓu t−îng lín, biÓu t−îng bÐ.. vµ hiÓn 

thÞ néi dung c¸c tÖp nµy b»ng c¸ch nhÊn vµo nót Play. 

2.6  Cöa sæ Timeline  

 

• B¹n ®· thu mét ®o¹n Video hoÆc Import c¸c file vµo trong Project. Chóng ta 

sÏ sö dông cöa sæ Timeline ®Ó tæ chøc c¸c tÖp (clip), thay ®æi thêi gian,  ®Æt 

Transition, ®Æt chång c¸c clip kh¸c, t¹o c¸c hiÖu øng,  lµm mê vµ quay... sau 

khi hoµn thµnh chóng ta cã thÓ export trùc tiÕp ra b¨ng hoÆc c¸c thiÕt bÞ kh¸c. 

• Cöa sæ Timeline: Timeline lµ n¬i  ®Ó x©y dùng mét ch−¬ng tr×nh Video  tõ 

c¸c  ®o¹n video vµ  audio nguån.  

PhÇn A

PhÇn B 
PhÇn C 



 
Tài liệu hướng dẫn sử dụng chương trình soạn thảo phim  

 

 
 
 
 

Trang 8

 
 

A. Vïng lµm viÖc  B. Vïng hiÓn thÞ thêi gian  C. Vïng lµm viÖc hiÖn thêi D. 

§¸nh dÊu ®iÓm so¹n th¶o   E. d¶i hÑp F. Timeline window menu G. Bé c«ng cô  

H. kªnh trªn cïng  I. Nót t¾t bËt hiÓn thÞ  kªnh J. Kªnh video 1  K. kªnh Audio  

L. Nót Track Header  M. kho¸ biÓu t−îng N. Phãng to thu nhá  O. Nót them c¸c 

kªnh Video/audio   P. nót b¸m dÝnh Video/audio  Q. Nót toggle Edge Viewing  

R. Nót cho phÐp ®¸nh dÊu c¸c tÖp trªn nhiÒu kªnh S. nót ®ång bé kªnh 

video/audio.  

2.7  B¶ng c«ng cô  

B¶ng c«ng cô gåm cã 8 nót. Khi nhÊn vµ  

gi÷ chuét t¹i c¸c nót nµy ta sÏ lùa chän  

®−îc c¸c chøc n¨ng cÇn thiªt. C¸c nót  

chøc n¨ng nµy rÊt quan träng trong viÖc 

so¹n th¶o Video. 
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2.7.1  Chøc n¨ng lùa chän  

Khi chóng ta muèn di chuyÓn, hay xãa mét hay nhiÒu  ®o¹n video trªn Timeline 

hoÆc ®Æt c¸c hiÖu øng cho c¸c ®o¹n video/audio ®ã th× tr−íc tiªn chóng ta phaØ  

dïng c«ng cô  x¸c ®Þnh ®èi t−îng  hoÆc nhãm ®èi t−îng.  Adobe premiere cung 

cÊp cho chóng ta mét nhãm c¸c c«ng cô ®Ó thùc hiÖn c«ng viÖc ®ã.  

• C«ng cô lùa chän ®¬n (chän mét  clip):  NhÊn vµo biÓu t−îng   ( ) vµ Chän 

®o¹n ®o¹n video (clip) trªn  

Timeline.  

• Lùa chän nhiÒu ®o¹n video (clip)  

b»ng c¸ch  nhÊn vµo nót thø 2, gi÷ 

phÝm tr¸i chuét vµ chän  ( ) sau ®ã ®¸nh dÊu khu vùc chøa c¸c ®o¹n video 

(clip). 

 Cã thÓ nhÊn phÝm SHIFT vµ nhÊn chuét vµo c¸c ®o¹n video (clip) kh¸c nhau ®Ó 

chän nhiÒu ®èi t−îng. Muèn  bá lùa chän cho mét ®o¹n video (clip) cã thÓ nhÊn  

phÝm CTRL vµ kÝch chuét vµo ®o¹n video (clip) ®ã. 

•  Lùa chän nhiÒu ®o¹n video (clip) trªn mét kªnh viedo/ audio b»ng c¸ch 

chän c«ng cô ( ).  Chóng ta cã thÓ dïng c«ng cô nµy ®Ó lùa chän tÊt c¶ c¸c 

®o¹n video (clip) tõ vÞ trÝ nhÊn chuét  hiÖn t¹i ®Õn cuèi kªnh video.  

 

 

 

•  Lùa chän nhiÒu ®o¹n video (clip) trªn nhiÒu  kªnh viedo/ audio b»ng c¸ch 

chän c«ng cô ( ).  Chóng ta cã thÓ dïng c«ng cô nµy ®Ó lùa chän tÊt c¶ c¸c 

®o¹n video (clip) tõ vÞ trÝ nhÊn chuét hiÖn t¹i ®Õn cuèi c¸c kªnh video.  
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2.7.2  Di chuyÓn, më réng, thu hÑp video  

 

Gi¶ thiÕt cã 3 ®o¹n Video n»m kÒ s¸t vµo nhau  

• Cuén mét ®o¹n Video mµ tæng thêi gian cña c¸c ®o¹n video (clip) lµ kh«ng 

®æi.            Lùa chän c«ng cô  ( ). 

 

 

 

 

              X¸c ®Þnh ®o¹n video (clip) cÇn so¹n th¶o.  KÐo sang ph¶i hoÆc sang tr¸i.  

Tù ®éng  ®o¹n Video kÕ bªn sÏ ®−îc më réng hay thu hÑp l¹i  

 

 
  

Trong tr−êng hîp nµy tæng thêi gian thùc hiÖn ®o¹n video (clip) lµ kh«ng thay 

®æi  

 Cuén ®o¹n video hiÖn t¹i mµ kh«ng ¶nh h−ëng ®Õn c¸c ®o¹n video (clip)  ë bªn 

c¹nh. Lùa chän c«ng cô   ( ). 
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 Lùa chän ®o¹n video (clip) cÇn so¹n th¶o vµ di chuyÓn vÒ bªn ph¶i vµ tr¸i  c¸c 

®o¹n video bªn c¹nh sÏ tù ®éng bÞ ®Èy vÒ bªn ph¶i hoÆc bªn tr¸i chø kh«ng bÞ 

thay ®æi.  

 

 

•  HiÓn thÞ ®o¹n video (clip) hiÖn t¹i : Lùa chän c«ng cô ( ). 

 

 

 Chän ®o¹n video (clip) cÇn hiÓn thÞ  vµ nhÊn phÝm tr¸i chuét vµ di chuyÓn chuét 

trªn ®o¹n video ®ã. 

• Tr−ît ®o¹n video (clip) hiÖn t¹i trªn c¸c ®o¹n video bªn canh. C«ng cô nµy 

gióp cho viÖc t×m c¶nh cuèi ®Çu vµ cña ®o¹n video (clip) hiÖn t¹i phï hîp víi 

c¶nh ®Çu vµ cuèi cña c¸c video kÕ bªn. 

Lùa chän c«ng cô   ( ). 
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Chän ®o¹n video (clip) vµ kÐo trªn sang ph¶i hoÆc sang tr¸i. Trªn mµn h×nh sÏ 

xuÊt hiÖn 4 c¶nh x¸c ®Þnh c¶nh ®Çu vµ cuèi cña ®o¹n video hiÖn t¹i so víi c¶nh 

trªn c¸c video kÒ bªn.   

2.7.3  Chia c¾t video thµnh nhiÒu ®o¹n vµ c¾t xÐn ®o¹n video    

 

• B¹n cã thÓ chia  mét ®o¹n video (clip) thµnh nhiÒu phÇn b»ng c«ng cô  ( ). 

C«ng cô nµy ®−îc sö dông nhiÒu trong tr−êng hîp muèn ¸p  dông c¸c hiÖu 

øng kh¸c nhau cho mét ®o¹n phim. 

•  Lùa chän c«ng cô ( )  vµ nhÊn chuét vµo vÞ trÝ cÇn c¾t trªn ®o¹n video 

(clip).  

 B¹n cã thÓ chia  nhiÒu ®o¹n video (clip) trªn nhiÒu kªnh video  thµnh nhiÒu 

phÇn b»ng c¸ch lùa chän c«ng cô  ( ) vµ nhÊn chuét vµo vÞ trÝ cÇn c¾t trªn ®o¹n 

video (clip).  

 

• Chän c«ng cô  Mark ( ) ( ) ®Ó c¾t cóp mét ®o¹n video 

• NhÊn  ( )  kÝch chét  vµo vÞ trÝ ®Çu cÇn c¾t cña ®o¹n  video (clip) 

• NhÊn  ( )  kÝch chuét vµo vÞ trÝ ®Çu cÇn c¾t cña ®o¹n  video (clip)  

2.7.4  Liªn kÕt video and audio clips trªn Timeline 

Khi b¹n ®−a néi dung mét ®o¹n video (clip) nguån vµo timeline th× tù ®éng 

®o¹n audio cña ®o¹n video ®ã còng ®−îc ®−a vµo theo liªn kÕt.  NÕu ®· cã  liªn 

kÕt  khi di chuyÓn video  th× audio còng ®−îc di chuyÓn theo.  T−¬ng tù nhu vËy 

khi c¾t d¸n, lùa chon th× c¶ phÇn video vµ audio cïng bÞ t¸c ®éng. 

  Chóng ta cã thÓ t¹o liªn kÕt hoÆc c¾t bá liªn kÕt b»ng c¸ch chän c«ng cô Select 

the link/unlink ( ).  NhÊn vµo ®èi t−îng ®−îc liªn kÕt sau ®ã nhÊn vµo ®èi 
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t−îng bÞ liªn kÕt. KÕt qu¶ lµ hai ®èi t−îng  ®−îc liªn kÕt víi nhau.  Muèn 

Unlink qua tr×nh ®−îc thùc hiÖn t−¬ng tù. 

 

 

2.7.5  T¹o c¸c  video ¶o trªn timeline 

 

  Video  ¶o lµ mét ch−¬ng tr×nh video thø  2  trªn timeline. Nã ®−îc x¸c ®Þnh tõ 

ch−¬ng tr×nh video chÝnh. Video ¶o cã thÓ chøa nhiÒu ®o¹n video (clip), c¸c 

chuyÓn c¶nh, c¸c hiÖu øng , nhiÒu kªnh video....  

 

 Video ¶o tæng hîp nhiÒu ®o¹n video (clip) trªn c¸c kªnh video vµ audieo kh¸c 

nhau lªn 1 kªnh video vµ 1 kªnh audio.  

 

 

  Chóng ta cã thÓ t¹o ®−îc c¸c video ¶o lång nhau. Tøc lµ khi t¹o ®−îc mét 

video ¶o chóng ta cã thÓ lÊy ®ã lµm nguån vµ t¹o tiÕp video ¶o thø hai. Ng−êi ta 

dïng video ¶o ®Ó  x©y dùng c¸c ch−¬ng tr×nh phøc t¹p víi c¸c hiÖu øng cao.  

Ch−¬ng tr×nh nµy cã kh¶ n¨ng  xö lý ®−îc 64 líp video ¶o.   

    V×  c¸c video ¶o nµy phô thuéc vµo  néi dung cña ch−¬ng tr×nh video thùc do 

®ã khi thay ®æi néi dung cña video thùc th× néi dung cña ®o¹n video ¶o còng bÞ 
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thay ®æi theo. Do ®ã khi sö dông video ¶o chóng ta nªn kho¸ c¸c kªnh video 

nguån ®Ó sau khi t¹o video ¶o. 

T¹o video ¶o 

Lùa chän c«ng cô  ( ). 

 

 NhÊn phÝm tr¸i chuét vµ chän vïng video cÇn t¹o video ¶o ( sao chÐp).  

Sau ®ã ký hiÖu nµy ( ) xuÊt hiÖn.   

KÐo khu vùc ®−îc ®¸nh dÊu ra  mét kªnh video  trèng.  KÕt qu¶ lµ ta thu ®−îc 

mét  

®o¹n video 

o.  

 Chóng ta cã thÓ  söa ®æi,  c¾t, di chuyÓn ... ®o¹n video ¶o nh− lµ mét 

®o¹n video (clip) thùc. 

2.7.6  Phãng to thu nhá  vµ di chuyÓn t×m kiÕm  ®o¹n video (clip)  

 Phãng to thu nhá ®o¹n video (clip). Chóng ta cã thÓ phãng to thu nhá ®o¹n  

b»ng c¸ch thay ®æi sè l−îng frame hay theo thêi gian cña ®o¹n video (clip) trªn 

timeline.  
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Chän c«ng cô  ( )  vµ ®−a chuét vµo timeline nhÊn chuét tr¸i ®Ó phãng to. 

Chän c«ng cô  ( )  vµ ®−a chuét vµo timeline nhÊn gi÷ phÝm ALT vµ nhÊn 

chuét tr¸i ®Ó thu nhá ®o¹n video trªn timeline. 

 

 Lùa chän c«ng cô                        vµ di chuyÓn chuét trªn vïng lµm viÖc cña 

cöa sæ timeline ®Ò t×m kiÕm mét ®o¹n video (clip).    

2.7.7  Thay ®æi tèc ®é cña ®o¹n video (clip) 

    Chóng ta cã thÓ t¨ng gi¶m tèc ®é cña ®o¹n video (clip) b»ng c¸ch thay ®æi tèc 

®é hay thêi gian thÓ hiÖn ®o¹n video ®ã. 

 C¸ch thùc hiÖn  

           Chän c«ng cô 

  ChuyÓn xuèng ®iÓm cuèi cña ®o¹n video (clip) vµ kÐo sang ph¶i hoÆc sang tr¸i 

®Ó më réng (gi¶n tèc ®é) hay thu hÑp (t¨ng tèc ®é ) cñ¨ ®o¹n video. 

2.8  Cöa sæ hiÓn thÞ kÕt qu¶ tõ Timeline 

Sö dông monitor ®Ó hiÓn thÞ clip, hiÓn thÞ néi dung trong Timeline, ®iÓu khiÓn  

Mµn h×nh hiÓn 
thÞ  tÖp nguån  

Mµn h×nh hiÓn 
néi dung  Video 
trong Timeline  

C«ng cô ®iÒu 
khiÓn Video 
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Input vµ Output,  ®¸nh dÊu,  thªm hoÆc bít, c¾t tØa  c¸c clip tõ Timeline. Cã thÓ 

hiÓn thÞ mét hoÆc hai cöa sæ. NÕu sö dông hai cöa sæ th×  mét cöa sæ sÏ hiÓn thÞ 

Video nguån cßn mét cöa sæ sÏ hiÓn thÞ kÕt qu¶. NÕu chØ cã mét cöa sæ th× nã 

chØ hiÓn thÞ kÕt qu¶ trong Timeline. 

Hai cña sæ nµy  hiÓn thÞ ®Çy ®ñ c¸c th«ng tin vÒ tÖp. Kh«ng nh÷ng thÕ chóng ta 

cßn cã thÓ  c¾t xÐn vµ chÌn c¸c ®o¹n Video cÇn thiÕt vµo ch−¬ng tr×nh.  

3. X©y dùng mét c¶nh Video tõ nhiÒu d÷ liÖu kh¸c nhau 

PhÇn nµy sÏ gióp chóng ta thùc 

hµnh víi c¸c chøc n¨ng vµ néi 

dung  c¬ b¶n cña cña ch−¬ng 

trinh Adobe Premiere th«ng qua 

c¸c b−íc ®Ó khëi t¹o  mét ®o¹n 

video qu¶ng c¸o vÒ xe ®¹p.  C¸c 

kü thuËt  ®−îc ¸p dông ®Ó x©y 

d−ng ®o¹n video nµy bao gåm 

c¸c kü thuËt c¾t xÐn video, 

chuyÓn ®æi gi÷a c¸c c¶nh,  t¹o 

hiÖu øng ®Æc biÖt cho mét ®o¹n 

video (clip) , t¹o chuyÓn ®éng 

cho mét ¶nh trªn ®o¹n video 

(clip), t¹o nÒn trong suèt, t¹o tùa 

®Ò  

cho video vµ cuèi cïng lµ chuyÓn thµnh tÖp video kÕt qu¶ víi ®Þnh d¹ng AVI. 

  C¸c tÖp d÷ liÖu ®Ó x©y dùng ®o¹n video trªn n»m trong th− môc :   

C:\ProgramFiles\Adobe\Premiere6.0\ Sample Folder\  

 hoÆc  trong th− môc  Sample Folder  trªn ®Üa CD_ROM cµi ®Æt ch−¬ng tr×nh. 

  C¸c tÖp d÷ liÖu nguån  lµ c¸c d÷ liÖu ®· ®−îc sè ho¸ vµ chuyÓn thµnh c¸c tÖp 

d÷ liÖu trªn m¸y tÝnh. Nã bao gåm c¸c tÖp  video cã ®Þnh d¹ng theo chuÈn 
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Window  cã phÇn më réng lµ AVI. TÖp ©m thanh cã phÇn më réng lµ AIF. TÖp 

¶nh lµ logo cña c«ng ty cã ®Þnh d¹ng theo chuÈn ¶nh Vector  víi phÇn  më réng 

lµ EPS. 

  NÕu chóng ta muèn kiÓm tra kÕt qu¶ cña qu¸ tr×nh so¹n th¶o th× chóng ta cã 

thÓ  hiÓn thÞ néi dung cña tÖp Zfinal ®Ó so s¸nh vµo bÊt kÓ thêi ®iÓm nµo.  

3.1.1  B−íc 1: chuÈn bÞ so¹n th¶o  

 Xo¸ bá c¸c tham sè −u tiªn. 

C¸c tham sè cµi ®Æt −u tiªn cã thÓ g©y ra c¸c lçi tranh chÊp  do vËy cÇn ®¶m b¶o 

khi b¾t ®Çu thùc hµnh  ch¾c ch¾n rµng ch−a khëi ®éng ch−¬ng tr×nh Adobe 

Premiere.  NÕu ®· ch¹y th× chóng ta chän File>Exit ®Ó ®ãng ch−¬ng tr×nh. 

Sau ®ã chóng ta khëi ®éng l¹i ch−¬ng tr×nh Adobe Premiere  

 NÕu nh− trong khi cµi ®Æt chóng ta ch−a  copy tÖp  th− môc Sample Folder lªn 

®ia cøng th× chóng ta cã thÓ t×m thÊy th− môc nµy trªn ®Üa CD-ROM cµi ®Æt vµ 

copy chóng lªn ®Üa cøng. 

3.1.2  ThiÕt ®Æt project 

Khi chóng ta khëi ®éng ch−¬ng tr×nh 

Adobe Premiere th× trªn mµn h×nh xuÊt 

hiÖn b¶ng sau:  

NÕu m¸y tÝnh cña chóng ta kh«ng cã 

thiÕt bÞ giao tiÕp víi Video ( cæng IE 

1394) th× chóng ta lùa chän kiÓu NTSC  

theo chuÈn Windows víi c¸c tham sè 

®Þnh s½n. Trong vÝ dô nµy chóng ta dïng cµi ®Æt nµy.  

Chóng ta cã thÓ thÊy ®−îc c¸c 

tham sè chuÈn ë cöa sæ 

Description víi lùa chän: 

 KiÓu video NTSC 

Cöa sæ thiÕt ®Æt tham sè  cho Project 
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 ChuÈn nÐn MJPG 

 KÝch cì khu«n h×nh: 720x480 

 ¢m thanh næi cã tÇn sè 44100Hz 

 Tèc ®é hiÓn thÞ: 29,97 h×nh/s 

 §é s©u mµu  16 triÖu mµu 

 ChÊt l−îng video cao nhÊt  

 

NÕu chóng ta muèn thiÕt lËp l¹i c¸c tham sè th× 

chóng ta chän môc Custome vµ chän:  

General Setting:  Hép tho¹i nµy cho phÐp ®iÒu khiÓn c¸c thuéc tÝnh c¬ b¶n cña 

ch−¬ng tr×nh Video.  Nã bao gåm  c¸c ph−¬ng thøc  mµ Premiere sö dông ®Ó xö 

lý video (Editing Mode), ®Õm thêi gian (Time Display),  hiÓn thÞ  

video(Timebase)  

Video Setting: Hép tho¹i nµy cho phÐp ®Æt l¹i kÝch cì cña frame, chÊt l−îng ¶nh, 

kiÓu nÐn, kiÓu hiÓn thÞ mµ Premiere playback tõ Timeline. C¸c tham sè trong 

môc nµy ¶nh h−ëng rÊt lín ®Õn chÊt l−îng Video.    

Audio setting: §iÒu khiÓn c¸c thuéc tÝnh audio khi mµ b¹n hiÓn thÞ ( playback) 

tõ Timeline. 

Keyframe vµ Rendering: §iÒu khiÓn c¸c thuéc tÝnh quan hÖ cña frame khi b¹n 

render vµ playback video tõ Timeline. Nh÷ng lùa chän nµy cho phÐp chóng ta 

chuyÓn kÕt qu¶ cña ch−¬ng tr×nh Video thµnh c¸c tÖp video  cã hoÆc kh«ng cã 

hiÖu øng.  

Capture setting: §iÒu khiÓn chÕ ®é chuyÓn video vµ audio c¸c nguån d÷ liÖu 

kh¸c nhau vµo ch−¬ng tr×nh so¹n th¶o. Cã thÓ tõ b¨ng, ®Üa, c¸c tÖp AVI, c¸c tÖp 

MOV...  
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 Chó ý khi ®Æt c¸c tham sè cho  project nh÷ng tham sè nµy sÏ x¸c ®Þnh râ chÊt 

l−îng cña s¶n phÈm khi b¹n playback tõ Timeline. VÝ dô: C¸c tham sè project sÏ 

x¸c ®Þnh ®é hoµ hîp cña c¸c yªu cÇu kÕt qu¶ hoÆc chóng cã thÓ t¹o  ra c¸c kÕt 

qu¶ víi chÊt l−îng thÊp. Nh− vËy m¸y tÝnh cã thÓ xö lý nhanh h¬n.  

NhËp d÷ liÖu vµo Project 

 Adobe Premiere  cã thÓ lÊy trùc tiÕp Video, audio, ¶nh  tõ  DV camera  th«ng   

qua cæng IEEE 1394, hoÆc tõ c¸c tÝn hiÖu Analog th«ng qua TV card . 

 Ngoµi ra chóng ta còng cã thÓ lÊy c¸c file, tõ ®Üa CD_ROM hoÆc c¸c file cã s½n. 

  Import mét hoÆc nhiÒu clip :  Premiere hç trî  c¸c ®Þnh d¹ng sau: AVI, MOV, 

AIF, TIF, JPEG, BMP vµ PSD.  NÕu c¸c file ¶nh cã chøa Kªnh Anpha th× chóng 

ta cã thÓ sö dông kªnh Anpha trong Premiere. 

- Chóng ta  cã thÓ Import c¶ mét th− môc b»ng c¸ch chän  File>Import > Folder  

- Chóng ta  cã thÓ Import mét hoÆc nhiÒu file b»ng c¸ch chän File>Import > 

File sau ®ã cã thÓ nhÊn gi÷ phÝm Shift ®Ó chän mét nhãm tÖp c¸c tÖp liªn tôc.  

NhÊn gi÷ Ctrl ®Ó chän c¸c tÖp rêi r¹c.  

Cöa sæ hiÓn thÞ danh s¸ch c¸c tÖp cã trong project  
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A. Mµn h×nh nhá hiÓn thÞ video B. C¸c th− môc C. C¸c ®o¹n video (clip) D. t×m 

kiÕm  E. T¹o th− môc (bin) F. T¹o biÓu t−îng  G. Xãa cac tÖp trong project H. 

Thay ®æi th− muc(bin) I. HiÓn thÞ d¹ng biÓu t−îng J. HiÓn thÞ c¶ frame ®Çu néi 

dung c¸c tÖp  K. HiÓn thÞ c¸c tÖp d¹ng danh s¸ch L. HiÓn thÞ ®Çy ®ñ th«ng tin M. 

Cöa sæ menu cña Project. 

Trong vÝ dô chóng ta dang thùc hµnh  chóng ta chän  File>import>files  sau ®ã 

chän th− môc C:\Program file\ Adobe\Premiere6.0\Sample Folder. Gi÷ phÝm 

Shift vµ ®¸nh dÊu 8 tÖp trong th− môc vµ chän Open. 

3.1.3  §−a Clip vµo Timeline   

Sau khi thu video vµ Import c¸c file vµo Project th× chóng ta cã thÓ  sö dông 

Timeline ®Ó so¹n th¶o c¸c Clip vµ t¹o c¸c hiÖu øng kh¸c nhau.  Chóng ta cã 

nhiÒu c¸ch ®−a mét tÖp Video vµo cña sæ so¹n th¶o  Timeline.   

C¸ch thø nhÊt dông Story board 

  Chóng ta cã thÓ sö dông Storyboar ®Ó nhËp vµo ®©y nhiÒu ®o¹n video. c¸c ®o¹n 

video  nay ®−îc s¾p xÕp theo thø tù cña chóng ta. Gi÷a c¸c ®o¹n video (clip) cã 

s½n chuyÓn c¶nh lµm mê ë phÇn nèi gi÷a hai ®o¹n video. 

C¸c b−íc thùc hiÖn: 

Khëi t¹o Story Board :  Chän 

File >New>Storyboard 

KÐo clip tõ cöa sæ Project vµo 

Storyboard  Mét chuçi c¸c 

clip t¹o bëi  viÖc kÐo  th¶ 

S¾p xÕp thø tù c¸c ®o¹n video 

(clip) theo kÞch b¶n.Tù ®éng 

gi÷a c¸c ®o¹n sÏ cã c¸c dÊu 

mòi tªn. C¸c dÊu mòi tªn nµy 

®¸nh dÊu chuyÓn c¶nh gi÷a c¸c ®o¹n video (clip).   
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Chän Project >Automate to Timeline 

Trong Automate Timeline  chän Placement vµ chän OK.  

Premiere tù ®éng transfer clip. 

KÕt qu¶ thu ®−îc: 

 

 

 

 

 C¸ch 

nµy  chØ 

¸p dông trong tr−êng hîp cã qu¸ nhiÒu ®o¹n video (clip) vµ t¹o ®o¹n video ®¬n 

gi¶n. Nã  lµm t¨ng tèc ®é ®−a c¸c ®o¹n video vµo Timeline.   

C¸ch thø hai kÐo th¶ trùc tiÕp tõ cña sæ Project vµo timeline 

 C¸ch ®¬n gi¶n vµ dÔ dµng nhÊt lµ  kÐo mét tÖp bÊt kú tõ cöa sæ project 

vµo mét track (mét kªnh video x, hoÆc audio x). 

 Th«ng th−êng th× ng−êi ta kÐo ®o¹n video (clip)  vµo cöa sæ Monitor  

tr−íc sau ®ã ng−êi ta kiÓm tra, ®¸nh dÊu  ®o¹n cÇn lÊy  råi míi thùc 

hiÖn viÖc ®−a ®o¹n video (clip) vµo timeline.  

 C¸c b−íc thùc hiÖn: 

 KÐo file nguån tõ cöa sæ Project vµo monitor bªn cöa sæ Source (cöa 

sæ bªn tr¸i) 

 NhÊn nót Play ( ) ®Ó kiÓm tra ®o¹n video (clip). §Õn ®Çu ®o¹n video 

cÇn lÊy nhÊn nót Stop ( ).  

 NhÊn vµo nót ®¸nh dÊu Mark in ({)   

 NhÊn nót Play ( ) ®Ó tiÕp tôc kiÓm tra ®o¹n video (clip). §Õn cuèi 

®o¹n video cÇn lÊy nhÊn nót Stop ( ).  
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  NhÊn vµo nót ®¸nh dÊu Mark out(})   

 ChÌn ®o¹n clip mµ chóng ta ®· c¾t tØa vµo Tracks b»ng c¸ch nhÊn  nót 

insert   hoÆc Overlay  

 

 

 

 

 

 

 

 

 

Trong vÝ dô dang thùc hiÖn chóng ta dïng c¸ch kÐo th¶ trùc tiÐp vµo cöa sæ 

timeline. 

Chän tÖp Boys.avi trong cöa sæ project kÐo vµo kªnh video 1 trªn cöa sæ 

timeline. T−¬ng tù ta kÐo tiÕp tÖp Cyclers.avi, Fastslow.avi. còng vµo kªnh 

video 1. 

 

 

 

 

 

Chóng ta cã thÓ thay ®æi diÖn m¹o cña ®o¹n video trªn timeline b»ng c¸ch  chän 

Windows > Windows option> Timeline  Windows option 
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 Chóng ta cã thÓ chän c¸c c¸ch thÓ hiÖn kh¸c 

nhau cña ®o¹n video trªn timeline.  

        Theo kiÓu tõng khu«n h×nh  

 Hai khu«n h×nh ®Çu, cuèi cña video vµ  

tªn tÖp. 

Khu«n h×nh ®Çu cña video vµ  tªn tÖp. 

ChØ cã tªn tÖp video . 

3.1.4  C¾t xÐn  mét ®o¹n Video(Clip) 

Trong mét clip th«ng th−êng th−êng cã mét sè c¶nh kh«ng cÇn thiÕt, chóng ta 

cã thÓ  bá c¸c c¶nh ®ã ®i.   

Trong vÝ dô ®ang thùc hiÖn chóng ta cÇn c¾t bá mét ®o¹n sau cña tÖp video Boys 

C¸ch thùc hiÖn: 

• Tr−íc tiªn chóng ta nhÊn nót Play ( )   trªn bé ®iÒu khiÓn cöa sæ Program 

bªn trong monitor  ®Ó kiÓm tra néi dung cña c¸c ®o¹n Video  trªn Timeline 

 

 

 

 

 

 

 

• Chóng ta cÇn x¸c ®Þnh vÞ trÝ cÇn c¾t bá cña c¶nh (tõ vÞ trÝ ®ã ®Õn cuèi ®o¹n 

video Boys sÏ bÞ c¾t bá) b»ng c¸ch kÐo thanh x¸c ®Þnh vÞ trÝ khu«n h×nh trªn 

timeline ®Õn vÞ trÝ ®ã. 
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• Chän c«ng cô ( ) sau ®ã nhÊn vµo vÞ trÝ ®· ®−îc lùa chän. Tù ®éng c¶nh 

video tõ vÞ trÝ hiÖn t¹i sÏ bÞ c¾t bá. 

• Chóng ta cã thÓ chän c«ng cô    ®Ó di chuyÓn tïng ®o¹n video (clip) vµo 

s¸t nhau. Nh−ng c¸ch tèt nhÊt trong tr−êng hîp nµy lµ sö dông c«ng cô  

®Ó lùa chän tÊt c¶  c¸c ®o¹n video (clip) trªn kªnh video1 tõ vÞ trÝ ®Çu cña 

®o¹n video Cyclers.avi. Sau ®ã gi÷ phÝm tr¸i chuét vµ keã vµo s¸t ®o¹n video 

Boys.avi. 

• Trong tr−êng hîp c¶nh video ch−a ®−îc chÝnh x¸c chóng ta cã thÓ lùa chän 

c«ng cô   sau ®ã ®−a chuét vµo vÞ trÝ cuèi cña ®o¹n video Boys.avi. NhÊn 

gi÷ phÝm tr¸i chuét vµ kÐo sang ph¶i hoÆc tr¸i mét vµi Frame. NÕu chóng ta 

muèn thËt chÝnh x¸c th× chóng ta cã thÓ chän view ®Ó phãng to ®o¹n Video 

ra.  

3.1.5  ChÌn ©m thanh vµo timeline 

• Chän tÖp music.aif trong cöa sæ project vµ kÐo vµo kªnh audio1 trong cöa sæ 

timeline.  

• NhÊn chuét tr¸i vµo nót expand track  (  )®Ó më réng kªnh audio.  Lóc 

nµy chóng ta thÊy cã hai ®−êng audio ( L,R). Chóng ta cã thÓ sö ®æi møc ®é 

c©n b»ng ©m thanh  gi÷a hai kªnh b»ng  c¸ch  kÝch chuét vµo ®−êng chÝnh 

gi÷a mµu xanh vµ kÐo lªn trªn hoÆc xuèng d−íi.  NÕu chóng ta muèn ®iÒu 

x¸c ®Þnh vÞ trÝ khu«n 
h×nh trªn timeline 
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chØnh møc ®é to nhá cu¶ kªnh audio víi c¸c kªnh kh¸c th× chóng ta cã thÓ   

nhÊn nót bËt chÕ ®é ®iÒu chØnh ©m thanh gi÷a c¸c kªnh. §−êng mµu ®á xuÊt 

hiÖn  cho phÐp chóng ta nhÊn chuét vµo, ®iÒu chØnh lªn xuèng t¹i c¸c ®iÓm 

kh¸c nhau. Nh− vËy ©m thanh sÏ cã c−êng ®é to nhá kh¸c nhau. 

 

 

NÕu chóng ta muèn bá mét ®iÓm ®iÒu chØnh ©m thanh th× chóng ta cã thÓ dïng 

chuét kÐo ®iÓm ®ã ra khái kªnh audio.  

NÕu chóng ta mu«n dÞch chuyÓn toµn bé ®−êng lªn hoÆc xuèng th× chóng ta 

chän c«ng cô   ®Ó ®iÒu chØnh. 

 

 

 

 

 

 

 

 

Trong tr−êng hîp vÝ dô nµy chóng ta nhÊn vµo nót nµy ®Ó kho¸ kªnh Audio. 

3.1.6  §Æt chÕ ®é chuyÓn (transition) gi÷a hai ®o¹n video 

ChÕ ®é chuyÓn c¶nh gi÷a hai ®o¹n video chØ thùc hiÖn ®−îc trªn kªnh video1  

Tr−íc tiªn chóng ta chän  c«ng cô  Selection   , nhÊn phÝm tr¸i chuét vµo tÖp 

Fastslow gi÷ chuét vµ kÐo xuèng track 2 cña kªnh Video 1.   

Chän Windows > Show transitions ®Ó më cöa sæ Transition. Chän  môc 

Dissolve>additive Dissolve 

Nót kho¸ , kh«ng cho phÐp söa ch÷a
kªnh Audio nµy  

Nót bËt chÕ ®é ®iÒu chØnh ©m 
thanh gi÷a c¸c kªnh  

Nót bËt chÕ ®é ®iÒu chØnh ®é c©n b»ng   ©m 
thanh(L,R) trong mét kªnh ©m.  

§−êng cho phÐp ®iÒu chØnh ®é to 
nhá hay ®é c©n b»ng  ©m thanh 
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Gi÷ phÝm tr¸i 

chuét vµ kÐo vµo 

phÇn transition 

gi÷a hai ®o¹n video 

Cyclers.avi vµ 

Fastslow.avi. Mét 

cöa sæ xuÊt hiÖn  

cho phÐp ®Æt thêi gian vµ vÞ cho chuyÓn c¶nh.  

 

Trong vÝ dô nµy chóng ta chän mÆc ®Þnh b»ng  

c¸ch chän OK hoÆc nhÊn Enter  

Nªó chóng ta muèn söa ch÷a chuyÓn c¶nh th× 

chóng ta cã thÓ nhÊn ®óp chuét  vµo biÓu t−îng 

chuyÓn c¶nh trªn kªnh Transition. Mét mµn h×nh  

nh− h×nh bªn sÏ xuÊt hiÖn cho phÐp chóng ta söa ®æi chuyÓn c¶nh.   

NÕu chóng ta muèn thay thµnh chuyÓn c¶nh kh¸c th× chóng ta cã thÓ  chän 

chuyÓn c¶nh cò, nhÊn phÝm DEL ®Ó xo¸ chuyÓn c¶nh nµy sau ®ã. Sau chän mét 

chuyÓn c¶nh kh¸c vµ thùc hiÖn l¹i  c¸c b−íc trªn. 

3.1.7  HiÓn thÞ Video Program 

   Primiere cung cÊp mét sè c¸ch hiÓn thÞ  tuú 

thuéc vµo viÖc b¹n muèn chän chÕ ®é hiÓn thÞ 

nh− thÕ nµo vµ  chÊt l−îng hiÓn thÞ  nh− thÕ nµo.   

  NÕu chóng ta kh«ng muèn  hiÓn thÞ mét kªnh 

video hoÆc mét kªnh Audio nµo ®ã  trong 

Nót t¾t bËt kªnh 
®ã trªn cöa sæ 
timeline 
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ch−¬ng tr×nh th× chóng ta cã thÓ nhÊn vµo nót t¾t kªnh ®ã trªn cöa sæ timeline. 

  NÕu chóng ta muèn hiÓn thÞ ch−¬ng tr×nh video trªn Timeline mµ kh«ng cã c¸c 

hiÖu øng hoÆc c¸c chuyÓn c¶nh ta chØ cÇn nhÊn phÝm ( )  trong cöa sæ Program 

cña monitor.  

   NÕu chóng ta muèn hiÓn thÞ  ch−¬ng tr×nh 

cã c¶ c¸c hiÖu øng th× chóng ta x¸c ®Þnh 

vïng lµm viÖc b»ng c¸ch ( kÐo thanh mµu 

vµng phÝa trªn cña cöa sæ Timeline ®Ó x¸c 

®Þnh khu vùc lµm viÖc) vµ nhÊn Enter.  

Premiere sÏ tù ®éng lùa chän vïng lµm viÖc, 

t¹o c¸c hiÖu øng (Building) vµ hiÓn thÞ chóng.  

    C¸ch nµy gióp cho viÖc kiÓm tra ®o¹n video  mét c¸ch  chÝnh x¸c vÒ thêi 

gian. 

    Cã thÓ gi÷ phÝm Alt ®−a chuét lªn thanh hiÓn thÞ thêi gian cña ch−¬ng tr×nh.  

NhÊn phÝm tr¸i chuét. Con trá chuét chuyÓn thµnh h×nh       . TiÕp tôc gi÷ phÝm 

tr¸i chuét vµ kÐo rª trªn thanh nµy.  Trªn mµn h×nh Program sÏ hiÓn thÞ néi 

dung cña c¸c ®o¹n video trªn timeline. 

§èi víi Audio khi ta trén c¸c kªnh vµ t¹o c¸c hiÖu øng cho audio, muèn kiÓm 

tra ta chØ cÇn nhÊn vµo nót Play trªn cña sæ Program mµ kh«ng cÇn nhÊn gi÷ 

phÝm ALT 

3.1.8  T¹o  hiÖu øng  cho ®o¹n video  

  Chóng ta chän tÖp  Finale.avi  trong cöa sæ project kÐo vµo kªnh video 2 trªn 

cöa sæ timeline vµ ®Æt vµo vÞ trÝ cuèi cña ®o¹n video Fastslow.avi. 

 NhÊn vµo nót  expand track  (  )  ®Ó më réng video 2. NhÊn vµo nót bËt chÕ 

®é hiÓn thÞ ®−êng ®iÒu chØnh ®é trong suèt cu¶ ®o¹n video.  

X¸c ®Þnh 
khu vùc 
lµm viÖc 

Thanh hiÓn thÞ thêi gian 
cña ch−¬ng tr×nh 
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Chóng ta ®iÒu chØnh ®o¹n video Finale.avi  hiÓn thÞ râ dÇn lªn  trong thêi gian 1 

gi©y sau khi ®o¹n video Fastslow.avi kÕt thóc b»ng c¸ch ®iÒu chØnh ®iÓm ®Çu 

cã gi¸ trÞ 1% ®iÓm cuèi (sau 1 gi©y) cã gi¸ trÞ lµ 100% .  Nh− h×nh trªn. 

TiÕp theo chóng ta hiÖu øng lµm mê nhoÌ  ®o¹n video  Finale.avi  ë phÇn cuèi. 

  Trong Premiere cung cÊp rÊt nhiÒu c¸c hiÖu øng  t¹o c¸c c¶nh Ên t−îng cho 

Video.  Nã bao gåm mét th− viÖn c¸c hiÖu øng nh− lµm mê, phãng to, thu nhá, 

t¹o sãng, t¹o ©m b¶n.... Trªn mét ®o¹n video cho phÐp ¸p dông  nhiÒu hiÖu øng 

cïng mét lóc.  

 C¸ch sö dông c¸c hiÖu øng nµy nh− sau:  

 HiÓn thÞ th− viÖn c¸c hiÖu øng   : Windows>Show video effects 

 HiÓn thÞ cña sæ ®iÒu khiÓn hiÖu øng:  Windows>Show effects Controls  

 X¸c ®Þnh ®o¹n video (Finale.avi )  

 KÐo  hiÖu øng Camera Blur trong th− viÖn effect vµo ®o¹n video trªn. 

 NhÊn vµo nót bËt chÕ ®é hiÓn thÞ thanh cho phÐp ®iÒu chØnh c¶nh video 

chÞu hiÖu  øng.  

 

 

Nót  expand track 
®Ó më réng video 

Nót bËt chÕ ®é hiÓn thÞ ®−êng ®iÒu 
chØnh ®é trong suèt cu¶ ®o¹n video 

§−êng ®iÒu chØnh ®é trong 
suèt cu¶ ®o¹n video 

1%
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    Trong th− viÖn c¸c hiÖu øng ( effect ) cã hµng tr¨m c¸c hiÖu øng kh¸c nhau 

nh− bãp mÐo h×nh ¶nh, thay ®æi mµu s¾c cña video, thay ®æi ®é mê, phãng to, 

thu nhá, chuyÓn ®éng ng−îc... Chóng ta cã thÓ lÊy ra rÊt dÔ dµng vµ ¸p dông cho 

c¸c ®o¹n video trªn cña sæ timeline b»ng c¸ch kÝch chuét vµo hiÖu øng vµ kÐo 

vµo ®o¹n video (clip) mµ chóng ta cÇn t¹o hiÖu øng.  

   §èi víi c¸c ®o¹n Audio chóng ta cã thÓ ¸p dông c¸c hiÖu øng t−¬ng t− nh− 

Video.  Chóng ta nhÊn chuét vµo  Windows>Show Audio  Effects ®Ó hiÓn thÞ  

th− viÖn c¸c hiÖu øng  Audio. Sau ®ã chän c¸c hiÖu øng vµ ¸p dông cho ®o¹n 

Audio.  

   Muèn söa ®æi hiÖu øng tr−íc tiªn chóng ta cÇn khëi t¹o c¸c Keyframe  trªn 

®−êng Keyframe. Sau ®ã cã thÓ ®Æt c¸c gi¸ trÞ hiÖu øng kh¸c nhau cho mçi 

keyframe trong cöa sæ effect Controls.  

   

 

 

 

 

 

 

 

Nót thªm, bít keyframe

Th− viÖn c¸c hiÖu øng 

Cöa sæ thay ®æi møc 
®é cña hiÖu øng  
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A. Nót bËt chÕ ®é hiÓn thÞ thanh cho phÐp ®iÒu chØnh c¶nh video chÞu hiÖu  øng  

 B.  ChuyÓn gi÷a c¸c Keyframe C. Nót chuyÓn ®æi c¸c hiÖu øng  D. §−êng 

Keyframe  

 

 A. Nót cho phÐp/kh«ng cho phÐp ¸p dông 

hiÖu øng       

 B.  Nót cho phÐp/kh«ng cho chuyÓn dÇn 

gi¸ trÞ hiÖu øng tõ mét keyframe  sang  

keyframe kÕ tiÕp 

 C. Tªn cña hiÖu øng  

 D. Thanh ®Æt gi¸ trÞ cho hiÖu øng  

 

 BiÓu t−îng keyframe phô thuéc vµo vÞ trÝ cña nã trªn ®−êng keyframe. Theo 

mÆc ®Þnh keyframe ®Çu tiªn vµ cuèi cïng cã mµu tr¾ng h×nh ch÷ nhËt ( ).NÕu 

chóng ta thªm vµo mét keyframe th× nã sÏ cã h×nh ( ), vµ c¸c keyframes ë hai 

®Çu sÏ chuyÓn thµnh h×nh( ).  

  NÕu biÓu t−îng lµ h×nh ch÷ nhËt  th× mÆc ®Þnh mét gi¸ trÞ cña hiÖu øng sÏ ®−îc 

¸p dông trªn toµn ®o¹n  keyframe ®ã ®Õn keyframe kÕ tiÕp. 

  NÕu biÓu t−îng vµ h×nh ( ) th× gi¸ trÞ cña hiÖu øng t¹i c¸c keyframe kh¸c nhau 

sÏ cã gi¸ trÞ kh¸c nhau. Vµ hiÖu øng chuyÓn dÇn tõ gi¸ trÞ t¹i keyframe nµy ®Õn 

keyframe kÕ tiÕp. 

Trong vÝ dô ®ang thùc hµnh chóng ta ¸p dông keyframe nh− sau:  

•  NhÊn chuét vµo nót cho phÐp  chuyÓn  dÇn gi¸ trÞ hiÖu øng tõ mét keyframe  

sang  keyframe kÕ tiÕp. Hai nót keyframe ë hai ®Çu  ®o¹n video chuyÓn 

thµnh h×nh tam gi¸c. 

•  V× chóng ta chØ lµm mê ®o¹n cuèi  cña tÖp video Finale.avi nªn ta ph¶i kÐo 

biÓu t−îng keyframe ë ®Çu ®o¹n video  sang ph¶i  b»ng c¸ch nhÊn gi÷ chuét 

tr¸i vµ kÐo ( nh− h×nh  bªn d−íi) 

 
 

Cöa sæ Effect Controls
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• T¹i vÞ trÝ míi chóng ta ®Æt gi¸ trÞ cña hiÖu øng lµm mê b»ng 20.  

• ChuyÓn ®Õn keyframe cuèi vµ ®Æt gi¸ trÞ b»ng 80. 

Chóng ta cã thÓ kiÓm tra l¹i kÕt qu¶ ®Ó ®iÒu chØnh gi¸ trÞ cña hiÖu øng vµ vÞ trÝ 

cña keyframe phï hîp h¬n. 

3.1.9  §−a mét biÓu t−îng vµo c¶nh video   

§−a logo vµo kªnh video 3 

• NhÊn  vµo nót thªm mét kªnh 

video  ë  gãc tr¸i phÝa d−íi mµn 

h×nh.  

• KÐo tÖp Veloman.eps vµo kªnh 

video 3  phÝa trªn tÖp Finale.avi 

• Dïng nót lùa chän ®Ó ®iÒu chØnh 

cho thêi gian phï hîp.  

Lµm mÊt mÇt nÒn cña logo b»ng c¸ch sö dông chÕ ®é transperency 

•  Chän tÖp Veloman.eps   vµ chän Clip>Video Option>Transperency.Cöa sæ 

hiÓn thÞ nh− h×nh bªn. 
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• Trong môc Keytype chän Alpha Channel 

• NhÊn vµo biÓu t−îng   . 

• Chän OK  

 

 

 

T¹o chuyÓn ®éng cho Logo 

• Chän tÖp Veloman.eps    

• NhÊn Clip>Video>Motion 

Cöa sæ Motion xuÊt hiÖn. ë chÕ ®é 

mÆc ®Þnh ®−êng  chuyÓn ®éng cña 

®èi t−îng lµ ®−êng th¼ng tõ tr¸i 

qua ph¶i.  Chóng ta cã thÓ ®iÒu chØnh l¹i ®−êng chuyÓn ®éng nµy b»ng c¸ch ®Æt 

l¹i ®iÓm ®Çu vµ cuèi, thªm mét ®iÓm vµo ®−êng chuyÓn ®éng vµ t¹o thµnh 

®−êng gÊp khóc  

 

C¸c gi¸ trÞ t¹i c¸c ®iÓm  ®Çu nh− sau:  

To¹ ®é ®iÓm ®Çu : -43 ,  0  

Gãc quay : 0  

§é phãng : 0 % 

Trong tr−êng hîp nµy ®iÓm b¾t ®Çu 

chóng ta kh«ng nh×n thÇy logo. Logo sÏ xuÊt hiÖn vµ to dÇn ra t¹i vÞ trÝ thø hai.  
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C¸c gi¸ trÞ t¹i c¸c ®iÓm thø hai nh− 

sau:  

To¹ ®é ®iÓm ®Çu : 0 ,  10  

Gãc quay : 0 

§é phãng : 100 % 

T¹i ®iÓm thø hai Logo sÏ xuÊt hiÖn to nhÊt v» b¾t ®Çu quay tõ 0 ®é.  

 

 

 

C¸c gi¸ trÞ t¹i c¸c ®iÓm thø ba nh− sau:  

To¹ ®é ®iÓm ®Çu : 26 ,  -8  

Gãc quay : 720 

§é phãng : 0 % 

Logo sÏ nhá dÇn tõ vÞ trÝ thø 2 vµ b¾t 

®Çu quay. Khi ®Õn vÞ trÝ thø 3 l«g sÏ biÕn mÊt h¼n vµ nã hoµn thµnh mét gãc 

quay tõ 0 ®é ®Õn 720 ®é. 

Chän OK ®Ó kÕt thóc qu¸ tr×nh nµy. Vµ kiÓm tra l¹i kÕt qu¶. 

3.1.10  §−a ch÷ vµo Video  

Chóng ta cã thÓ ®−a  ch÷  vµo c¸c tÖp video  b»ng c¸ch t¹o ra mét tÖp  v¨n b¶n  

b»ng c¸ch  chän : File> new> title.  Mét cöa sæ  so¹n th¶o v¨n b¶n  xuÊt hiÖn 

nh− h×nh d−íi 
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NhÊn chuét vµo c«ng cô    vµ vÏ mét cöa sæ  trong vïng so¹n th¶o. 

So¹n th¶o dßng ch÷  “CH¦¥NG TR×NH THùC HµNH aDOBER 

pRERIEME trong 1 giê “  vµo khung cña sæ võa t¹o. 

 

 

 

 

 

 

 

CH¦¥NG TR×NH
THùC HµNH 

aDOBER 
pRERIEME 

trong 1 giê 

Hép  c«ng cô t¹o 
text vµ biÓu t−îng 

C«ng cô ®Æt mµu 

C«ng cô t¹o bãng  

Cöa sæ so¹n th¶o  
Text vµ logo cho 
Video 

Menu ®Æt c¸c thuéc 
tÝnh cho TEXT  
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 Cã thÓ thay ®æi mµu ch÷ b»ng c¸ch chän tõ b¶ng mµu trªn hép c«ng 

cô. 

 Cã thÓ thay ®æi ®Þnh d¹ng ch÷ b»ng c¸ch vµo môc Title > Font 

 NhÊn gi÷ chuét ph¶i vµo phÇn phÝa 

d−íi cña cöa sæ vµ kÐo vµo kªnh video 

3 tiÕp theo ®o¹n video Veloman.eps    

 Mét cöa sæ hiÓn thÞ cho phÐp ghi lai 

tÖp nµy. §Æt tªn  tÖp lµ Text.plt 

 Chän c«ng cô  vµ kÐo dµi tÖp text 

trªn kªnh video 3 kho¶ng 2 gi©y. 

 NhÊn phÝm Alt vµ gi÷ chuét tr¸i vµ kÐo 

trªn th−íc thêi gian ®Ó kiÓm tra. Dßng 

ch÷ sÏ tõ tõ chuyÓn ®éng lªn phÝa trªn. 

 NÕu chóng ta mu«n thay ®æi  h−íng chuyÓn ®éng cña ®o¹n text chóng 

ta chän Title> Role title option 

3.1.11  ChuyÓn  kÕt qu¶ thµnh tÖp avi  

 X¸c ®Þnh khu vùc lµm viÖc (cÇn export) trªn cña sæ timeline. 

 Chän File > Export Timeline> movie  

 Cöa sæ Export movie xuÊt hiÖn.   

 §Æt tªn cho tÖp video kÕt qu¶  

 NhÊn vµo môc setting trong cöa sæ nµy mét cöa sæ cho phÐp ®Æt  l¹i 

c¸c tham sæ video vµ audio xuÊt hiÖn.   
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Gi¸ trÞ c¸c tham sè nh− sau:    

File Type : Microsoft AVI 

Range : Work Area,  Export Audio, Export Video,  Open When Finished 

Video: 

Compressor: Indeo Video 5.10 

Frame site : 480x324 

Frame rate: 29,97 

Pixel Aspect Ration: D1/DV 

NTSC(0.9) 

Depth: millions, Quality 85% 

Audio:  

Rate: 32000 

Format : 16 bit – Sterio 

Compressor : Uncompressor 

Cac gi¸ trÞ kh¸c ®Ó mÆc ®Þnh. 

Chän OK.  

Chän Save.  
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Adobe Premiere tù ®éng chuyÓn ch−¬ng  

tr×nh video trªn Timeline thµnh tÖp kÕt qu¶ vµ 

hiÓn thÞ l¹i trªn mµn h×nh . 

NhÊn nót Play ®Ó xem l¹i.  
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Tµi liÖu tham kh¶o 

 

1. Adobe Primerie 6.0 uses guide  

2. http://wwwam.hhi.de/mpeg-video/contact.htm 

3. http://www.ebu.ch/trev_dolby_frm.html  

4. http://www.msstate.edu/movies/ 
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